OnBase Quick Reference Guide
Scanning Documents

This Quick Reference Guide covers setting up the scan station and using a scanner to
import batches of documents into OnBase using the Unity client installed on a Windows
PC. Departments are generally licensed for one to two scanners per group. To install the
Unity client, refer to the OnBase Web URLs and Unity Client ClickOnce URLSs.

Batch Indexing is covered in separate guides (Indexing documents — Unity Client and
Indexing documents — Web Client).

Configuring your Scan Station

Perform these steps to configure your scan station. Not all users will have access to
make these changes; contact your departmental administrator or UIS for assistance if
necessary. You should only have to perform these steps once for each scan station.

1. Login into the Unity Client with your campus credentials.

First, select your campus. Depending on the size of the window, you may see campus
names only or the campus names along with pictures. Single click on campus names or
double click if the picture is displayed.
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Select your campus for authentication:

Boulder IDP
Denver IDP

Colorado Springs IDP

System

Single click to select the desired campus.
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https://www.cu.edu/doc/onbase-web-urls-and-unity-client-urls-v4.pdf
https://www.cu.edu/doc/onbase-qrg-indexing-documents-unity-clientdocx
https://www.cu.edu/doc/onbase-qrg-indexing-documents-web-clientdocx
https://www.cu.edu/uis/onbase-certified-department-administrators
mailto:UIS_DM_Support@cu.edu
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Select your campus for

Colorado Springs IDP

Double click to select the desired campus.

2. Enter your campus credentials. For assistance with your campus credentials,
refer to the links on the login page for your campus. Go to the File menu and select
User Options.
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3. Select Imaging from the list at the left of the User Options window.
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4.

General

WorkView
Document
| Imaging |
ocal Data
Printing
Retrieval Date Options
Revision Control
Service Mode

Signatures
Workflow

User Options

General Options

[] Confirm Exit/Logoff
Enable Animations
[] Enable Pop-up Motifications

[] Refresh Internal Mail
Internal Mail Refresh Rate

[] Enable default directory for Send To File operations
Directory:

Search Options

Automatically display document viewer with search results

[] Allow case-sensitive sorting and grouping of search results

Save

Cancel

Select Production Document Imaging (KOFAX or TWAIN) and click Save.
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5 User Options - 0 x
General . . A
, License Option
WorkView |
i Document Use the following license on this workstation to enable batch scanning
Document Import
) i Mone
Imaging
Local Data I ® Production Document Imaging (KOFAX or TWAIN) I
Printing ) Producticn Uocument [maging |1 veAlMN]
Retrieval Date Options  Batch Scanning
HEWSI?” Control [] Enable image previews during sweep
SE?'CE Mode Preview images displayed per minute (60-360)
Signatures [] Disable Document Review
Waorkflow [] Advanced Document Review
Batch Processing
[] Hide batch counts
[] Hide sub status queues
[] Hide document counts
[] Automatically select Auto Load Mext Batch
Display batch locks
Batch Indexing
Enable the review actions warning v

Click Batch Scanning on the Home tab of the menu

Item Viewer

O E E.:\ Q\ [ Envelopes Document Handle T E @q

(D Query History <) Certified Records

Home Personal Favorites  Custom  Retrieval File N Forms Import Templates Reporting Mailbox  Workflow Batch Batch
- Page - - Queries Cabinets E’MyChE‘kD“ts Scanning | Processing
Favorites Documents Create Reporting  Internal Mail | Workflow maging

h Mls|k

Click the gear icon for Manage Scan Formats on the Batch Scanning tab of the

Home Capture

® ﬁ G @}) Scan Source

e

Scan  5can From  Sweep  Refresh Batch Scan Format

w Manage Global

Disk List Processing
Capture Layout Configuration

Scan Formats

Administration

Click New to create a new scan format.
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Manage Scan Formats

Favorites

Import Formats

8. Type a name for your new scan format and select the Source Type.

e *

MNew Scan Format

MName

X - U5 - Mew Scan Format

Source Type
Twain w |
Ok Cancel
9. Choose your scanner from the available scanners list and click OK.

10. If needed, refer to the appropriate guide in the Scanning/Sweeping section of the
OnBase Training page for instructions on setting up your scanner’s profile.

Scanning Documents

Now that your scanner is configured, you are ready to scan your documents. Perform
these steps to scan into OnBase.
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1.

2.

3.

Open the Unity client and log in using your PeopleSoft Operator ID. If you do not
know this, contact your local OnBase Administrator.

OnBase

[] Remember me on this computer

| Legin | ‘ Cancel

Copyright © 1082 - 2018 Hyland Software, Inc
All Rights Reserved. Build Version 18.0.1.42

Click Batch Scanning on the Home tab of the menu

ltemn Viewer

(D Query History <) Certified Records
- Page » - Queries Cabinets EMyChE‘kDUtS

O E G.:\ O\ [ Envelopes Decument Handle T E @] m E é Q})

Home Personal Favorites  Custorn Retrieval File Forms Import Templates  Reporting Mailbox  Workflow Eatch Batch

Favorites Documents Create

Scanning | Processing
Reporting  Internal Mail | Workflow maging

Choose the appropriate scan queue for the documents being scanned. You can
use the search bar at the top of the list to help find the desired scan queue.

University of Colorado

Boulder | Colorado Springs | Denver | Anschutz Medical Campus


https://www.cu.edu/uis/onbase-certified-department-administrators

4.

5.

File Home Capture

™ ‘]
4G &
From Sweep Refresh Batch
List Processing

Scan Source

Scan Format

Capture Layout
Batch Scanning

Scan Queue
p——

Configuration

test

S - ES - Testing Scan Queue [0]
5 - UIS - Testing Scan Queue (IDC) [0]

Batches
I

Batch # Batch Name

] N ]

=

Manage Global
Scan Formats

Administration

Scan Mode
® Mo Index ) Pre-Index O Full Index

Document Type

Document Date

Employee Lookup

# Keywords

Sweep

Choose one of the following scan modes.

Scan Mode
® Mo lndex

Document Type

Document Date

) Pre-Index

0 Full Index

a. No index: All document type selection and keyword value indexing will
occur in Batch Processing after the batch is scanned.
b. Pre-index: The document type will be selected prior to scanning the
batch. Keyword values can be entered as well, but the batch will still
require additional indexing for other keyword values.
c. Full Index: The document type and all keyword values will be entered

prior to scanning the batch. The batch will bypass the initial indexing status

gueue and will move straight to the Awaiting Commit status if no other

indexing is required.

Click Scan in the lower right-hand panel or on the Capture tab of the menu.
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OnBase (DMOPRD)

Capture
S [» s | | &
= can Source v
® ﬁ N » — @ i
Scan From  Sweep  Refresh Batch Scan Format | v | Manage Global
Disk List Processing Scan Formats
Capture Layout Configuration Administration

Batch Scanning

Scan Queue A Scan Mode
test ® No Index ) Pre-Index O Full Index
S - ES - Testing Scan Queue [0] Document Type

S - UIS - Testing Secan Queue (IDC) [0]

Document Date

Employee Lookup

A Keywords a &

Batches A
.|
Batch # Batch Name
=] - =]

I I Sweep

6. Enter a name for your batch (if prompted, some scan queues will create the name
automatically) and select your scan format.

Batch Name

3rd Party Batch Batch # created on 10/11/2018 by Larissa

Scan Format

5F5 - Barcode Separation - Color

7. At this time, make sure the documents have been placed into the scanner’s
feeder tray and are ready for scanning (staples, paper clips and sticky notes removed).
Then click Scan.
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Batch Name
3rd Party Batch Batch # created on 10/11/2018 by Larissa

Scan Format

|SF5 - Barcode Separation - Color

8. When all pages have been scanned, you will be prompted with the following
options. Most of the time “Done” should be used.

) X

Scanning complete

Tetal number of pages scanned =6

Scan More Pages Continue adding pages to current batch or document

Mew Document Create a new document within batch

Create a new document with a new document type within batch

| v

Change Format Modify the current format before continuing

Discard Pages Discard scanned pages

I Done Scanning complete I

Delete LastImage | Delete the last image (back of the last page) and continue

Delete the last page and continue. If the scanning mode is

Delete Last Page duplex delete both the front and back of the last scanned page.

[elete Last Document | Delete the last document and continue

9. At this time, you can review pages and make any necessary changes. If
Advanced Document Review is enabled in User Options, that will be displayed at this
time. When you are ready to send the batch to indexing, click Back to go back to Batch
Scanning to scan another batch or Go to Batch to go to Batch Processing and begin
indexing.
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Back Goto §Previous Mext  Rescan  Add  Delete Rotate Rotate Rotate
Batch | Page Page  Page Page(s) Page  Left Right

Document Review Document Image

@ G ED IR

Pages Orientation

Batch Scanning

rMavigation

Scanned Documents - Batch Name: Cash Receipts created on 9/27/2017 by ARMA000017(141137) - 5 Documents

[1] Cash Receipt for - - 9/27/2017

[1] Cash Receipt for - - 9/27/2017

[1] Cash Receipt for - - 9/27/2017

Cash Receipt for - - 9/27/2017

. .
. . Effective Date: 01/01/2015
| { E: liniversitv nf Colorads P O

Sweeping Documents
In addition to scanning paper copies, OnBase also allows for documents that already
exist electronically to be imported as batches from a folder on your computer or network.

Perform these steps to sweep into OnBase.

1. Open the Unity client and log in using your PeopleSoft Operator ID. If you do not
know this, contact your local OnBase Administrator.

OnBase:

2] |
& | |

[] Remember me on this computer

| Legin | ‘ Cancel |

Copyright © 1982 - 2018 Hyland Softwars, Inc

All Rights Reserved. Build Version 18.0.1.42

Click Batch Scanning on the Home tab of the menu

ltermn Viewer
4 = [ Envelopes [E1 Document Handle = (=} 7]
0O 2] ESNISN (B oec * & »
(D Query History <7/ Certified Records :
Home Personal Favorites  Custom  Retrieval File - Forms Import Templates Reporting Mailbox Workflow Batch Batch
- Page - - Queries Cabinets E’M)‘ Checkouts Scanning | Processing
Favorites Documents Create Reporting  Internal Mail | Waorkflow maging
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3. Choose the appropriate scan queue for the documents being scanned. You can
use the search bar at the top of the list to help find the desired scan queue.

File Home Capture o
é G ‘)» Scan Source V é‘@
From Sweep Refresh Batch Scan Format v Manage Global

5 List Processing Scan Formats
Capture Layout Configuration Administration

Batch Scanning
Scan Queue = Scan Mode

test ® NoIndex ) Pre-Index O Full Index

S - ES - Testing Scan Queue [0] Document Type
S - UIS - Testing Scan Queue (IDC) [0]

Document Date

Employee Lookup

A Keywords a &

Batches A

I

Batch # Batch Name

m ST m

Sweep
4. Choose one of the following scan modes.

Scan Mede
® Mo ndex ) Pre-Index () Full Index
Docurnent Type

Document Date

a. No index: All document type selection and keyword value indexing will
occur in Batch Processing after the batch is scanned.

b. Pre-index: The document type will be selected prior to scanning the
batch. Keyword values can be entered as well, but the batch will still
require additional indexing for other keyword values.

c. Full Index: The document type and all keyword values will be entered
prior to scanning the batch. The batch will bypass the initial indexing status
gueue and will move straight to the Awaiting Commit status if no other
indexing is required.

5. Click Sweep in the lower right-hand panel or on the Capture tab of the menu.
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OnBasze (DMOPRD)

Home Capture

® é G @ Scan Source | ~ | é@
Fr Sweep i

Scan  Scan From

Refresh Batch Scan Format | ~ | Manage Global
Disk

List Processing Scan Formats
Capture Layout Configuration Administration

Batch Scanning

Scan Queue E Scan Mode
test ® Nelndex O Pre-Index O Full Index
S - ES - Testing Scan Queue [0] Document Type

S - UIS - Testing Scan Queue (IDC) [0]

Document Date

Employee Lockup

A Keywords g &
H
2
Batches #
.|
Batch # Batch Mame
=] - m]

| Sweep I

Choose whether you would like to sweep all files in a folder, or just one file.

x

Which method do you wish to use to sweep files?

Sweep all files in a particular directory

& Import one file

@ Cancel

e To sweep all files in a folder, click the browse button at the right and navigate
to the desired folder. Make any optional selections, then click Sweep.
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Sweep Directory

[] Delete Files After Sweep

[] Sweep Images Only

Image Orientation
(® Mo Rotation [] Flip Vertically
() Rotate Left 90 degrees [] Flip Heorizontally

() Rotate Right 90 degrees
() Rotate 180 degrees

I Sweep I Cancel

e |f you choose to sweep only one file, a file browser window will open. Navigate
to the desired document and click Open.

7. At this time, you can review pages and make any necessary changes. If
Advanced Document Review is enabled in User Options, that will be displayed at this
time. When you are ready to send the batch to indexing, click Back to go back to Batch
Scanning to scan another batch or Go to Batch to go to Batch Processing and begin
indexing.

Document Review

e
- 4 i [ E] a
© & =10
Back Goto JPrevious Mext  Rescan Add Delete  Rotate Rotate Rotate
Batch Page Page Page Page(s) Page Left Right  180°
Navigation Pages Orientation

Batch Scanning
Scanned Documents - Batch Name: Cash Receipts created on 9/27/2017 by ARMA000017(141137) - 5 Documents @

[1] Cash Receipt for - - 9/27/2017
[1] Cash Receipt for - - 9/27/2017
[1] Cash Receipt for - - 9/27/2017

Cash Receipt for - - 9/27/2017

[ _ Effective Date: 0770172075 ‘ ‘
{;q liniversitv nf Colaradn : 2
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